Outline for Course and Clerkship Coordinator/Faculty Education

Developing your Blackboard Course for iPad Delivery

Help and Support from Miner Library Staff ............................................................................................................. 2  
UR SMD Document and Technology Standards ...................................................................................................... 3  
Document Reader – Notability App .......................................................................................................................... 3  
Creating PDF’s from Microsoft Office ..................................................................................................................... 4  
Adding Document Attachments in Blackboard ......................................................................................................... 7  
Timed Release of Student Documents/PBL Case Documents ................................................................................... 10  
Blackboard Mobile Learn .......................................................................................................................................... 12  
Multimedia ............................................................................................................................................................... 12  
Testing/Quality Assurance .......................................................................................................................................... 12

Update July 1, 2013
Help and Support from Miner Library Staff

Course Coordinator/Instructor Support
Please contact Blackboard Support in the global address list for any assistance with your Blackboard course development and maintenance. Blackboard Support can answer most questions and defers to the Online Learning Team for questions that require further investigation. Blackboard Support uses a ticketing system to ensure that all inquiries are addressed in a timely fashion. This system also allows the staff to track inquiries, which helps inform information included on the Blackboard Support webpage.

Checking for iPad Compatible Versions of Textbooks
If you would like a librarian to investigate whether there are iPad compatible versions of your required or recommended textbooks, contact Michele Shipley, Assistant Director of Digital & Branch Libraries: Michele_Shipley@urmc.rochester.edu or 585-275-6878.

Student Support
Please direct students to the Miner Library Computing Center/Blackboard Support Desk when they are having problems with accessing your courses in Blackboard or with their Blackboard account. Staff at the Answer Desk can direct students to the Computing Center. The Computing Center is located between the entrance to Miner Library and the Quiet Zone.
Phone: (585) 275-6865
Email: Blackboard Support

Group Classes
Miner Library offers free monthly Building Your Academic Course in Blackboard group classes. This class offers guided, hands-on practice with adding and removing content, managing users of the course, and applying adaptive release rules. Sign up for a class on the Miner Library website: http://www.urmc.rochester.edu/libraries/miner/teaching_and_learning/class_schedule.cfm
UR SMD Document and Technology Standards
The URMC School of Medicine and Dentistry has defined the following standards:

Learning Management System (LMS)
Blackboard Learning System is the system the University of Rochester uses for managing and delivering course materials. Course materials will be accessible for both iPad and desktop computer delivery. Safari and Mercury web browsers are the recommended ways to access learning materials on the iPad. Accessing Blackboard through the Blackboard Mobile Learn App is currently not recommended as not all course material can be viewed as intended when using the app.

Document Format – PDF Standard
Office documents, including Word and PowerPoint files, can be saved and delivered as PDF documents. PDF is a standard mobile and web document format, unlike MS Office. In addition, PDF files are much smaller than Office documents, enabling users to download documents quickly, and allow for bookmarking, which makes information within documents searchable. The consistent use of the PDF format will help to ensure a smooth, student friendly experience.

Discontinuation of Printing
Syllabi for iPad/mobile courses will no longer be printed for students. Rather, students will need to access syllabi exclusively online through Blackboard. For this reason, it is strongly recommended to add Microsoft Word Heading Styles to syllabi to promote easy access and navigation. See section on Page 4 - Adding Headings within Your Word Document.

Software Requirements
For best results we recommend using:

- Microsoft Office 2010
- Adobe Acrobat Pro X

Document Reader – Notability App
Notability is an iPad app that supports reading, annotation, saving and sharing of documents. Students are provided with this app and are able to download documents from Blackboard directly into Notability.
Creating PDF’s from Microsoft Office

Creating White Space
White space allows for areas on the document where students can take notes using their iPads. Please use wide margins to facilitate note taking alongside the text.

Preparing Documents to Use Heading Styles

Introduction
Bookmarks are extremely useful for finding information quickly within large PDF documents, and are highly recommended for helping students use the online-only versions of documents. As printing versions of the syllabi will no longer be provided, the need for effective bookmarking is underscored. This recommendation came initially from medical students who requested document bookmarks when providing feedback regarding their Blackboard and iPad experience.

Adding Headings within your Word Document
Headings are bolded section titles throughout the document, which are used to create a table of contents, work in Outline mode, and to add bookmarks when converting to PDF. Heading styles are found in the Home tab, Styles section. Headings can be applied before, during, or after the document is created.

It is recommended that you use these three heading levels; **Heading 1**, **Heading 2** and **Heading 3**. Heading 1 is used for the title of a main section, followed by Heading 2 and Heading 3 for subsections.

To apply a Heading, select the words in the heading by clicking and dragging, and then click on Heading 1 (or Heading 2 or 3 for subheadings). Click here for a demonstration.

Saving PDF from Microsoft Word with Bookmarks (Native MS Office Save)
There are different ways to save Bookmarks into your PDF file when saving from Microsoft Word, depending on the tools and versions you have. It is recommended that you use Adobe Acrobat Pro X (see Page 6 – Saving/Converting Using Adobe Acrobat Pro X). There is a cost associated with Adobe Acrobat Pro products. If you do not have Acrobat Pro X, below is one straightforward way to ensure
that your PDF document will have bookmarks. This approach requires that you have applied Heading Styles, as indicated in the previous section.

*Please note the following procedure is only available when working with MS Word on a Windows machine. If the original MS Word file is formatted as above, using a MAC, save the file as a pdf document directly in Acrobat Pro.

Steps:

1. Click the File tab in the top left of the screen. Select > Save As <
2. From the “Save as type” dropdown menu, select “PDF” (see figure below)

![Save As PDF](image)

3. Once you have selected the PDF file type, an “Options” button will be displayed. Select Options.
4. Check the box and radio button to Create bookmarks using Headings, then save the document. The document will then automatically open up in Adobe Acrobat Reader as a PDF.

![Create Bookmarks](image)

5. From Adobe Acrobat Reader, you can check your bookmarks by clicking on the Bookmarks icon in the PDF document. This quality assurance check will help to ensure that you have not used Heading styles in places where they don’t fit. For example, heading styles will not work for column headings in a table. If you have extraneous bookmarks, follow these steps:
   a. Go back into the Word document and locate the text that should not be a heading.
   b. Change the style to normal by highlighting the text and clicking Normal in the Styles section of the menu bar.

![Normal Style](image)

   c. Please note, you will need to re-save the PDF.
Saving Microsoft PowerPoint Documents as PDF (Native MS Office Save)
To save a PowerPoint document as a PDF, simply “save as”, then select “PDF” as the file type. The issue with saving from Microsoft PowerPoint is that slide titles will not automatically be converted to PDF bookmarks. It can be argued that bookmarks are not as essential for converted PowerPoint presentations as they are for converted Word documents, but they do make navigation much easier in both cases. That is why the use of Acrobat Pro is recommended.

Saving/Converting using Adobe Acrobat Pro X
Adobe Acrobat Pro is highly recommended for course coordinators and/or faculty who will be converting a lot of documents for the following reasons:

1. When saving PowerPoint presentations as PDF using Acrobat Pro, slide titles will automatically be converted to PDF bookmarks. This feature is not supported using the native Microsoft Office PowerPoint PDF save function.
2. Acrobat Pro supports saving to “progressive” PDF’s. This means that PowerPoint transitions and animations saved will be saved in the PDF file.
3. If you use Acrobat Pro to convert MS Word documents, then the Heading Styles will automatically be saved as bookmarks in the PDF file. This is also supported via native Microsoft Office “save”, but the native Microsoft Office feature requires an extra step to configure your save option to create bookmarks from headings.
Adding Document Attachments in Blackboard

**Important! Naming Your Documents**
Before uploading document files to Blackboard, please take a moment to add the acronym name of the course, followed by an underscore, type of instruction, underscore, and name of document. For example, a document with the name, “A Stitch in Time” that is used in a PBL session for Molecules to Cells would be named, MTC_PBL_A Stitch in Time. Another example, a document with the name, “Bacterial Diseases” used for a Host Defense presentation would be named HD_Lecture_Bacterial Diseases. Names for the types of instruction are not set in stone, so please use your best judgment when naming that part of the document.

**Use a Desktop or Laptop Computer to Build Your Course**
For best results, upload content (documents, web links, videos, etc) from a desktop or laptop computer rather than from the iPad. Your materials are likely located on your desktop or laptop and building Blackboard courses is much more efficient this way. Use your iPad to test your course as a quality assurance measure. This will help to ensure a smooth learner experience.

**Option1. Build Content -> Create File**
One way to attach documents into your Blackboard course is through the Build Content menu Create File option. Simply select the content folder where you would like to place the document, select Build Content, and then select File.

You will be prompted to browse for the file, and to give the file a recognizable name. It is recommended that you select “Open in New Window”. Although this latter setting will not actually impact iPad users, it will facilitate a smoother experience for desktop users.
Option 2. Item Attachment

Another way to attach a file is by adding it as an attachment within an Item. This method is recommended if you would like to add supplemental text in addition to the file itself. If there is no supplemental text needed, then Option 1 is recommended.

To add an item, use **Build Content->Create ->Item**.

To add supplemental text, go to part 1, give the item a name and then navigate to the box labeled Text. This is the text editor box. Type the text as you would a word processing document. Hover over the symbols to find out what kind of text editing options are available.

To attach a file with the item, go to part 2. Attachments. Browse for the file and attach.
Important: Please do Not Attach Files using the Text Editor Box– Not iPad Compatible

Many documents for past courses were attached within the Text Editor Box of the Create or Edit Item screen. This style of attachments will not work with the iPad.

1. **Content Information**

   - **Name**
   - **Color of Name**
     - Black
   - **Text**

   ![Image](image.png)

   **Please Do Not Attach Files inside this Text Editor Box – Will not work in iPad**

   ![Image](image.png)

   **Path:** p  
   **Words:** 0

If you have pre-existing items that have attachments done this way, then those documents will need to be removed and reattached using Option 1 or 2 above.

**Possible Lag Time**

During testing a lag time of up to 20 minutes was noted between the time that new course content was added to the course and the time that the content appeared in the Blackboard Mobile Learn iPad course. This does not happen all of the time, but to be safe, please upload content at least 20 minutes prior to the start of class or PBL session.
**Timed Release of Student Documents/PBL Case Documents**

It may be necessary to hide course materials from students until a specified time. One example of this need is PBL case documents.

PBL case documents will no longer be provided in hard-copy printed format for courses delivered via the iPad. Rather, students will retrieve case documentation during the PBL session through the Blackboard course. In order to prevent students from seeing the documents prior to the PBL session, release of documents will need to be timed to correspond with the PBL class time.

**Steps for setting up a Timed Adaptive Release Rule on a Document or Folder**

1. **Make the folder, file, or item available**

   To set up a timed adaptive release for a document or folder, first ensure that the folder or file is visible to students. The item must be available to start with in order for the release rule to work. If an item is not available, in Edit Mode you will see a message “Availability: Item is not available”.

   ![Image](image1)

   To make an unavailable item available, hover over the item to reveal the edit arrow, select Edit, and then select >Yes< for >Permit Users to View this Content<. The name of the option may vary slightly depending on which item type you are editing.

   ![Image](image2)

   3. **Standard Options**

      - Permit Users to View this Content: Yes/No
      - Track Number of Views: Yes/No
2. Select “Adaptive Release” from the dropdown menu next to the folder, file, or item.

3. In the “Date” section configure both the date and time that you would like the item to become visible, be sure the small box to the left is checked, and then click the “Submit” button (you might have to scroll up or down) to save this Adaptive Release rule.

   1. Date

   Setting a Date criterion for this item will restrict the dates and times of the visibility of this item.

   Choose Date
   
   Display After [06/28/2013] 10:00 AM
   Enter dates as mm/dd/yyyy. Time may be entered in any increment.

   Display Until
   Enter dates as mm/dd/yyyy. Time may be entered in any increment.
Blackboard Mobile Learn

Supported and Unsupported Features
Blackboard Mobile Learn for iPad supports many, but not all of Blackboard functions. In particular, not all of the interactive tools are fully supported in the Mobile Learn App. The primary focus of this tutorial is the uploading of documents rather than the use of interactive tools. If you are interested in advanced usage of Blackboard for the iPad, please consult with the Online Learning team.

Multimedia

Media Types Supported and Unsupported
If you are linking to multimedia, please use the “Build Content -> Create -> Web Link” option.

Flash media format and several other media formats such as Windows Media are not supported natively on the iPad. The iPad does support MP3, H.264, and several other types of video and audio format. A detailed description of supported media formats can be found at: [http://www.ifunia.com/ipad-column/ipad-supported-video-and-audio-formats.html](http://www.ifunia.com/ipad-column/ipad-supported-video-and-audio-formats.html)

If you are unsure of the format of the media you are linking to, please contact Blackboard Support and we will assist you in determining whether or not a specific media resource will work for the iPad.

Testing/Quality Assurance
It is highly recommended that you test your course via the iPad as a quality assurance measure because workflow from the iPad is different from the Blackboard desktop workflow. This testing step will inform course design decisions and help to ensure a smooth learner experience.